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Order and Report
Management

Objectives
In this chapter, you will:

• Manage orders and reports on the Explorer tab

• Use the Dashboard tab

• Create templates for print, fax, and cover sheets
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Managing Orders and Reports on the 
Explorer Tab 

You can use the Explorer tab in the Exams group to find and manage orders and reports. This 
tab provides access to the orders and reports in your system. It contains a search area for quick 
search by accession numbers and patients, another to invoke worklists, and another for using 
search filters. The system remembers your filter selections from one session to the next.

Once you have found the order you want to see, you can take various actions on it. You can: 

• Associate an order with a report 

• Reset an order’s status to ‘Draft’

• Modify an order’s priority level

• Modify a report’s diagnosis codes

• Change values in the custom fields

• Change a patient’s MRN

• Download a printable version

Quick 
Search

klist 
rch

Search 
Filters
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Report audio is available in the Explorer only if the Save Audio with Report dictation 
preference is in effect (see page 75). A Nuance representative must configure the amount of 
time the system is to save the audio files.

Searching for Orders or Reports Across All Sites
Use the Look for field to search for orders or reports across all sites in a multi-site system.

Note: The Look for search option does not take into account any of the other drop-down 
filters on this tab. These filters do not apply when you are doing a quick search. 

To search for orders or reports:

1. In the Look for drop-down list, select the criterion for the search you want to perform: 
Accession Number, Patient MRN, or Patient Last Name. 

2. In the text entry field, type all or part of the accession number, MRN, or name. 

3. Click Search. Any orders or reports that match your criteria appear in the results grid.

Tips: 

• You can use an asterisk as a wild-card character; for example, select Patient Last Name 
and then type Smi* to find patients whose last names begin with Smi. Or, select 
Accession Number and then type 1234, *56*. The search returns the accession number 
1234 and all the accessions that contain the string 56. 

• You can use the percent character as a wild-card replacement for one or more 
characters; for example, select Patient MRN and type 1111%2. The search returns 
MRNs such as 11102, 11142, 11162, and 11192. 

• To search for multiple accessions, enter each accession followed by a comma. 

Retrieving Worklists
In the WL (worklist) box, you can execute previously-defined, system-wide worklists. For 
information on creating worklists, refer to Chapter 16.

To retrieve a worklist:

1. In the WL drop-down list, select the desired worklist.

2. Click Search. Any orders or reports that meet the criteria in the worklist appear in the 
results grid. 

Using the Search Filters
This set of filters allows you to search for orders, reports, or both that meet the criteria you 
select. Filters with a value other than All create a logical AND expression; that is, the filter 
retrieves only orders and reports that meet all your criteria. 
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To search using the filters:

1. Select or enter one or more of the following criteria for your search. 

• Site: In a multi-site system, search for orders and reports in a particular site.

• Order Status: Search for orders of a particular status. The table below describes 
each status:

• Patient Class: Search for a particular type of patient (Inpatient, Outpatient, 
Pre-Admit, Emergency, Recurring Patient, or Obstetrics). 

• Account: Search based on the resident who dictated the report, or the attending 
physician who dictated or is assigned to the report. Or, search by the transcriber or 
technologist. Inactive user accounts are omitted from the list. 

• Locking: Search based on a report’s lock status (All, Locked, Unlocked, Assigned, 
Unassigned, Locked or Assigned, Unlocked and Unassigned). Locked reports are 
those currently being dictated. 

• Report Status: Search for reports of a particular status. The table below describes 
each status:

Status Description

All Uses all order statuses in the search.

Canceled Order was canceled.

Completed Order has been completed and is ready for reporting.

Scheduled Order has been scheduled but not performed.

Temporary Indicates a temporary order.

Dictated Ext.

Status Description

Addended One or more addenda have been created for a final report. Addenda are 
reports themselves and the aforementioned statuses apply to them too.

All Uses all report statuses in the search.

Completed (All) and 
Completed (Unreported)

Exam has been performed and is ready for dictation.

Draft
Draft (A)
Draft (S)

Draft (T)

Report has been started and saved, but not completed.
A indicates an addendum.
S indicates scheduled. Depending on the interface configuration the report 
might not be eligible to be sent to the RIS until the order is completed.
T indicates temporary.
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• Section: Search based on customized site sections. This filter is disabled if you 
have not selected a site.

• Ordering Physician: Search for exams ordered by the selected physician from a 
site. This filter contains only active physicians who have ordered at least one exam, 
and is disabled if you have not selected a site. Begin typing the physician’s name, 
and then select the name from the list that appears.

Final
Final (A)
Final (Asgd)
Final (S)

Final (T)

Report has been completed and signed by an attending.
A indicates an addendum.
Asgd indicates an assigned report that is pending an addendum.
S indicates scheduled. Depending on the interface configuration the report 
might not be eligible to be sent to the RIS until the order is completed.
T indicates temporary.

Pending Correction Report has been dictated and queued for correction.

Pending Signature Report has been dictated and queued for signature.

Preliminary Pertains to any report whose status is not final.

Rejected Appears when a corrected report is returned to an editor by an attending or 
resident, or when a Pending Signature report is returned to a resident by an 
attending.

Scheduled Exam has been scheduled but not yet completed. Sometimes, the exam has 
been completed but the status has not been updated in the RIS. In this case, 
reports can be dictated, but are not delivered to the RIS until they are marked 
complete. Some sites may choose not to allow dictation for scheduled orders.

Temporary Exam has not been received by PowerScribe 360 Reporting so a temporary 
order has been created. In this case, reports can be dictated, but are not 
delivered to the RIS until the actual order is received.

Unreported No report has been dictated for the order.

Wet Read A “pre-draft” state. Either attending or resident providers can create a wet 
read report. Any attending or resident provider can promote a wet read report 
to a Draft status. The text of the wet read is maintained once the report is 
promoted to Draft status.

Status Description
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• Time Frame: Search for orders or reports based on a period of time. For unreported 
orders, the filter is based on the time of the exam. For reported orders, the filter is 
based on the time the report was last modified. This filter includes values such as 
Past hour, Past 4 hours, Today, Yesterday, Past 2 days, Past 3 days, Past week, Past 
2 weeks, Past month, Tomorrow, All Future, and No limit. To specify a range, click 
Custom and then indicate the start and end dates. These dates are inclusive.

• Transfer Status: Use this filter to search based on report transfer status (All, 
Exceptional, Not Ready, Ready, Sent, Rejected, Failed, Held, Queued, Force Send).

• Location: Use this filter to search based on the site location associated with the 
order. This filter is disabled if you have not selected a site. 

2. Click Search. Any orders or reports that meet your criteria appear in the results grid.
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Using the Search Results
The results grid shows all reports and orders that meet your search criteria.

Tip: 

• If a report is associated with multiple orders, each order that satisfies the search 
criteria appears separately in the grid. 

• If the report has an addendum, the properties listed (status, attending, and so on) refer 
to the addendum. 

• If the search yields more than one page of results, click the page number at the bottom 
right corner of the grid to navigate to a specific page. To view the entire list, click the 
small down arrow at the right of the page number list. The arrow then reverts to an up 
arrow; click the up arrow to see the results one page at a time.

• Hover your mouse cursor over the page label to see the total number of items found. 

Results Gri
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• Click any column heading to change the sort order. The software remembers the order 
you selected. Click the heading again to sort in reverse order.

• If you invoke a worklist that contains a sort order, the results initially appear in this 
order, and the grid footer displays the order. Apply a different sorting by clicking a 
column heading.

Note: There is a limit on the number of orders you can retrieve at one time. This limit is set 
by default to 500 in the Maximum Explorer Search Records system preference, found on 
the Explorer Screen tab in the System Preferences window. 

The Locking and assignment status, Report transfer status and Priority columns 
provide some important information about the reports and orders that appear in the list. 

Column Description

Locking and assignment status The icon in this column can be either yellow or blue. 
Yellow indicates that the report is open and therefore locked. 
Hovering your mouse over the lock icon shows who has 
locked the report.
Blue indicates an order that is assigned to a radiologist other 
than the logged-in user. Depending upon a site preference, 
(page 59) you might, or might not, be able to open this order.

Report transfer status Hover your mouse over the order’s icon to see the status:
Ready: Report is flagged for inspection; when it is sent 
depends upon its status and interface options.
Queued: Report is queued for transmission.
Force Send: Report is queued for immediate 
re-transmission.
Sent: Report has been successfully delivered.
Sent & Edited: Report has been edited since it was 
distributed; the version of the report in the RIS/HIS is old 
and does not match what is in PowerScribe 360 Reporting.
Final Exported: Final report has been successfully 
transmitted.
Rejected: The RIS rejected the report.
Failed: An error occurred.
Held: An administrator interrupted the transmission.

Priority This column uses icons to indicate an order’s priority: 
No icon: Routine priority

STAT priority
ASAP (red)
Timing-critical; Callback; or Pre-op (yellow)
Low priority (green)

TAT Deadline Indicates reports that have reached or surpassed their turnaround 
time deadline:

Indicates the report is past its deadline. Hover your mouse 
cursor over the icon to see a tool tip describing how far past 
the deadline the report is.
4 L-3906-006



Chapter 18: Order and Report Management

L-
Order/Report Preview 
Each accession number in Accession column of the results grid is a hyperlink to an order 
and report preview page. This printer-friendly page also provides patient data, exams 
associated with the report, the report’s addenda, and any notes, custom fields, or 
attachments.
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In addition to the preview, there is an audit trail for the order and report, showing when the 
report was received from the RIS, when it was created, edited, signed, and so on. In the 
Content column of the audit grid, there are icons you can click to download the report 
content at various steps in the reporting process.

You can download the plain text (.txt), the formatted text (.rtf), or the dictated audio (.wav) 
of the current report independently of the audited content. These files are available for the 
number of days specified in the Keep Content Audit for Final Reports option in the 
System Configuration dialog box (Setup > System > Configuration). Final reports are 
typically deleted after a few days so that the database does not grow too rapidly. 

Holding, Releasing, or Sending an Order or Report
If you hold a report, it is not sent to the RIS, even if it has been signed as preliminary or 
final. To make a held report or order eligible for transfer, you must use the Release option. 
You can release only completed orders and final reports that have been held. 

Note: You can release preliminary reports only if you have set the Send 
Preliminary Results option and the Send Dictated Status Updates option for the 
Bridge service (Setup > Bridge). 

• The Release option changes the report’s transfer status from Held to Ready, which 
prepares the report to be examined by the Bridge software. The report may or may not 
be sent, based on the options configured for the Bridge and for the destination systems. 

• The Send Now option forces the report to be sent within a few seconds, regardless of 
the way the Bridge options are configured.

To hold an order or report: 

1. Find the report or order you want to hold. 

2. Place a check mark next to the report or order. 

3. Click Hold. You see a confirmation message. 

4. Click OK. A Held icon appears in the Report Transfer Status column next to 
the order or report, indicating that it is being held. 
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To release an order or report:

1. Find the report or order you want to release. 

Tip: Use Held as the Transfer Status filter to search for all held orders and 
reports. 

2. Place a check mark next to the report or order. 

3. Click Release. You see a confirmation message. 

4. Click OK. A Ready icon appears in the Report Transfer Status column next to 
the order or report, and the order or report is now eligible to be sent. 

To send an order or report immediately:

1. Find the report(s) or order(s) you want to send. 

2. Place a check mark next to the report(s) or order(s). 

3. Click Send Now. You see a confirmation message.

4. Click OK. The report or order is transferred. 

Faxing an Order or Report
You can fax one or more reports or orders from the Explorer tab. 

To fax orders or reports: 

1. Find the report or order you want to fax.

2. Place a check mark next to each item you want to fax. 
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3. Click Fax…. The Fax Report dialog box opens.

4. In the To: field, select the recipient’s name. The default destination is the ordering 
physician, or the referring physician if the ordering physician name is unavailable.

5. In the Number: field, type the fax number. 

6. If you want a cover page to accompany the fax, select Cover Page and type the 
Subject and Message that are to appear on the cover page. For information on defining 
cover page templates, refer to Creating a Fax Cover Sheet, beginning on page 514.

7. Click Send to send the fax(es). 

Unlocking an Order
While a provider is dictating a report on an order, the order is locked to prevent other users 
from opening it. Later, the order is unlocked. The order might remain locked in some 
circumstances, such as a loss of network connection. When the provider logs in again 
when the connection is restored, any locks are automatically cleared. You can use the 
method below to unlock an order manually, if necessary. 

To unlock an order: 

1. Find the order you want to unlock.

Tip: Use the Locking Status filter to search for all locked orders.

The locked order shows a padlock icon next to it.

2. Place a check mark next to the order. 

3. Click Unlock. The lock is cleared. 
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Associating an Order with a Report
Use this feature to associate an order with a report. You can:

• Add another order to a report. Any orders already associated with it remain in place.

• Replace an order with another one. 

• Remove an order from a report that has multiple orders.

To associate an order with a report:

1. Find the report to which you want to associate an order.

2. Float your mouse cursor over the Action link next to the report, and select Associate... 
from the shortcut menu. The Order Association dialog box opens.

3. Indicate the action you want to take: Add an order to this report, or replace the existing 
order with another one. Or, if there are multiple orders associated with a report, you 
have the option of removing the currently selected order. 
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4. Click Next >>. A list of unreported accessions for this patient is displayed.

5. Select the order you want to associate with the report and click Next >>. A 
confirmation message indicates the association has been made, or removed, depending 
on the action.

6. Click Close. The original list is updated to reflect your change. 

Resetting a Report’s Status to ‘Draft’
To reset a report to ‘draft’: 

1. Find the report whose status you want to reset. 

2. Float your mouse cursor over the Action link next to the report, and select Reset to 
draft from the shortcut menu. A confirmation message appears.

3. Click OK. The report’s status reverts to ‘draft.’
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Modifying an Order’s Priority Level
To modify an order’s priority level:

1. Find the order whose priority you want to reset. 

2. Float your mouse cursor over the Action link next to the order, and select 
Set Priority … from the shortcut menu. The Set Priority dialog box opens.

3. Select the priority level you want to assign to this report. 

4. Click Change. The report’s priority is changed to the level you selected. An icon 
appears in the Priority column to show the priority:

Modifying a Report’s Diagnosis Codes
This feature allows you to set diagnosis codes for reported orders.

To modify a report’s diagnosis codes: 

1. Find the report whose diagnosis codes you want to modify.

2. Float your mouse cursor over the Action link next to the order, and select Edit 
Diagnosis Codes… from the shortcut menu. The Order Diagnosis Codes dialog box 
opens. 

Routine: No icon

Low priority:

Timing-critical, 
callback, or pre-op:

ASAP:

STAT:
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3. Find the diagnosis code you want to assign to the report. 

To find a code:

 a. Type all or part of the code or its description in the Diagnosis Code/Description 
field. You can use an asterisk as a wild-card character. 

 b. Click Search to find the codes. Select the Restrict to exam codes option if you 
want to search only amongst exam codes, and not diagnostic codes. The codes 
appear in the All codes list at the left.

4. Place a check mark next to each code you want to assign to this order. Or, place a 
check mark in the heading to select all the codes in the list. 
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5. Click Add. The selected codes are added to the Selected Diagnosis Codes list at the 
right. To remove a code, place a check mark next to it and click Remove.

6. Click Save and Close to assign the codes to the order. 

7. Repeat Steps 3 through 6 until you have added all the desired codes to the order. 

8. Click Close Window.

Modifying an Unreported Order or Report’s Custom 
Field Values

Note: For more information on custom fields, see Custom Fields, beginning on page 325.

You can change the values the radiologist or other user has inserted in the custom fields in 
an unreported order or report. 

To modify the custom fields:

1. Find the order or report whose custom field values you want to change. 
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2. Float your mouse cursor over the Action link next to the order or report, and select 
Edit Custom Fields… from the shortcut menu. The Order Custom Fields dialog box 
opens.

3. Enter or select the appropriate value for each of the custom fields in the order or 
report. 

4. Click Save Changes. 

5. Click Close Window to return to the report list.

Changing a Patient’s MRN
To change a patient’s MRN:

1. Find the order or report in which you want to change the patient’s MRN. 

2. Float your mouse cursor over the Action link next to the report, and select Change 
Patient MRN from the shortcut menu. The Change Patient Identifier dialog 
box opens.

3. Type the patient’s new MRN. 
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4. Click Change. A notification message appears.

5. Click OK. 

Canceling an Order
Because some RIS do not send order cancellations through HL7, you can set the status of 
an exam to Canceled to keep the data synchronized between PowerScribe 360 Reporting 
and your RIS. You can cancel only unreported orders whose status is not Temporary or 
Entered.

To cancel an order: 

1. Find the order you want to cancel. 

2. Float your mouse cursor over the Action link next to the order, and select Cancel from 
the shortcut menu. A confirmation message appears.

3. Click OK. The order’s status changes to Canceled. 

Printing an Order or Report
You can print any order or report in the system; the report will appear in the same format 
as it does when the radiologist prints it from the PowerScribe 360 Reporting client 
application. The report will include any headers, footers, page numbering, or other 
features you defined in the default print template for the system, site, or site location. For 
more information on setting up print templates, refer to Creating a Print Template, 
beginning on page 501.
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To download a printable report: 

1. Find the report(s) you want to print. 

2. Place a check mark next to each report you want to print. 

3. Click Printable…. The standard File Download window opens.

4. If you want to view the report(s), click Open. The report opens in a Word or WordPad 
window, depending on the file type. From here, you can save or print the document. 

OR

To save a copy of the report(s), click Save. A standard Save As window opens. 
Navigate to and select the folder where you want to save a Word file containing the 
report(s), and click Save. The file is stored at the location you specified. 

Deleting Reports and Orders
Caution: Deleting reports or orders is not recommended and should not be done except in 
rare cases where your RIS is not synchronized with your PowerScribe 360 Reporting 
system. 

Deleting a report or an order removes it from the PowerScribe 360 Reporting system, but 
does not remove it from the RIS. In most cases, you do not need to delete reports or orders 
from the system. If an unusual situation requires you to delete a report or order, follow the 
procedure below. 

To delete a report or order:

1. Find the order or report you want to delete. 

2. Place a check mark next to the order or report. 

3. Click Delete. A confirmation message appears.
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The options you see depend on the order or report you selected. For example, if you 
delete an order associated with a visit that has no other unreported orders, you have an 
option to delete the visit:

4. Select the appropriate option(s) and click Delete. A message indicates the successful 
deletion of the item(s).
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Using the Dashboard Tab

The Dashboard tab in the Exams group provides a real-time view of exam activity in the 
system. It has three tabs, each showing a different set of exam-related activities.

• User Activity: Shows all users currently logged into the system, including Portal 
users, how long they have been logged in, the workstations they are using, the exams 
on which they are working, and the last action taken on these exams. 

• Inbound Activity: Shows all recent messages received from the RIS. 

• Outbound Activity: Shows all recent messages sent to the RIS. 

• DICOM Activity: If you purchased the DICOM option, this tab is available.

The User Activity tab contains two actions that you can perform. In the far right column of the 
list, a red and white icon allows you to terminate a client session. Or, in the lower-left portion 
of the window, you can click the blue terminate link to terminate all open client sessions.
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Dashboard Refresh Rate
Use the Configuration page in the Setup group to specify how often the data is updated on 
the Dashboard. The default is every 30 seconds.
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Introduction to Templates

You can create print, fax, and cover sheet templates for your facility’s needs. You can design 
templates for the entire system, for individual sites, and for locations within sites. If your 
facility is converting from the RadWhere application, you can use your existing RadWhere 
templates in PowerScribe 360 Reporting. 

Templates allow your reports to have a consistent appearance when they are printed or faxed. 
If you assign a template to the system, all reports printed in the system use that template, 
unless you also assign templates to individual sites or locations within sites. With a template, 
a report has the same appearance whether a radiologist prints it from the client application or 
an administrator prints it from the Explorer tab in the Administrator Portal.

To tailor a template to your facility’s needs, you can use advanced features such as merge 
fields, tabs, page numbering, headers, footers, tables, and embedded graphics such as logos. 
And, you can design a template to show a different header or footer on the first page than on 
the other pages. (Nested tables and separator lines are not supported.) 

If desired, you can design separate templates with different headers and footers for each site or 
location; for example, you might want reports to display a different department name and 
address at the top of the page depending on the site or location. You can create the same or 
different templates for printing and faxing. 

You can create and edit simple templates in WordPad; for the more advanced features, you 
will need to use Microsoft Word. You must save print and fax templates as .rtf files, not as 
.doc files, before you upload them to your system in the Portal. You can use any .rtf file as a 
basis for a new template. 

Note: Cover sheet templates are not .rtf files; these have a .cov extension and you can 
create them only in the Microsoft Fax Cover Page Editor utility that comes with Windows.

Use the procedures below to create and edit templates that will be available to all users in the 
system, for individual sites, or for locations within sites. 
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Creating a Print Template

To add a new print template at the system or site level, you must first create the template 
as an .rtf file in Microsoft Word or WordPad. Once you have created it, you must add it to 
your PowerScribe 360 Reporting system. 

To create the template:

1. Create the template file in Microsoft Word or WordPad. 

• Use Word’s advanced features to add headers, footers, page numbering, and so on, 
if desired.

• A print or fax template must, at the minimum, contain the <maintext> merge field. 
This field will contain the text of the report; you must place this field at the position 
where you want the body of the report to appear. 

• You can add other merge fields such as the patient name, patient MRN, attending 
name, and so on. Below is an example of a print template with merge fields.

Place the <maintext> 
merge field at the position 
where you want the body 
of the report to appear. 
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To see a list of all available merge fields: 

 a. On the System or Sites tab in the Setup group, click Templates….

 b. Click the icon at the upper right of the Print Template tab.
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A window showing the list of merge fields opens. 

You can copy any merge field from the list to insert it in the document. For example, to 
insert the visit number, copy the field <401:Visit Number> and paste it at the position 
in your template where you want the visit number to appear. Although you can use the 
field number alone or the field name alone, it is recommended that you copy the field 
exactly as it appears, including the brackets. 
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Tip: To insert a custom field, use this format: <10000:Custom:Custom Field 
Name>. For example, if the custom field name is Radiation Dose, type 
<10000:Custom:Radiation Dose>. 

Appendix A in this manual also contains a list of the merge fields you can use in your 
print templates. 

2. When you have finished creating the template, save it as an .rtf file. Make a note of the 
path and folder location where you saved the file. Then continue with the procedure 
below to upload the template to your system. 

To add a print template to the system, site, or location:

1. To add a print template at the system level: 

 a. On the System tab in the Setup group, click Templates.

 b. Select the Print Template tab.

OR

To add a print template at the site level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Click Templates. 

 c. Select the Print Template tab.

OR

To add a print template at the site location level: 
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 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location for which you want to add a template, click Edit in the 
Templates column.

2. Click New. 

The Create Template dialog box opens.

3. Type a Name for the new template. 

4. Click Browse.

5. Navigate to and select the file you created in Word or Wordpad. Click Open. The path 
and file name appear in the File field.
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6. Click Save. The template appears in the plain-text preview window.

7. To preview the template as it will appear with a report, click the link below the editing 
window. At the prompt, click Open. A sample report appears in a preview window. 
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(This preview does not display any real data in the merge fields, but shows how a 
typical report might appear in the template.)

 

Close the preview window when you have finished viewing the sample report.

8. Click Save and Close to save the template on your server. 
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Show Addendum at the Top of Printed Reports
Merge fields are available for printable templates that allow a report’s addenda to appear 
at the top of the report, rather than near the end, allowing report recipients to be alerted 
immediately to the most recent information about a patient.

Note: The merge fields can also be used to create other highly customized print templates, 
including control over the headers and separators that appear with each section.

Print Template Merge Fields

Simple Approach
<maintextreverse> - Prints report with addendums at top in reverse chronological 
order, using hard coded headers and separator lines between each addendum and the 
original report.

Complex Approach (for customers who want more control of separators)
<addendum-start> <addendum-end> <addendumtext>

<originalreport-start> <originalreport-end> <originalreporttext>

<report-start> <report-end> <reporttext>

Notes: 

• <originalreport> may be used as a synonym for <originalreporttext>, <report> is 
a synonym for <reporttext>, and <addendum> is a synonym for <addendumtext>.

• <originalreportextt> refers to the original report only when an addendum exists. 
Thus, both the <originalreporttext> and <reporttext> tags may be used in the same 
template to customize the output for the original report when addendums exist, such 
as to add a different banner.

• If an addendum exists, but the report template does not include an 
<addendumtext> tag, the template is considered invalid since the addendum(s) 
cannot be included in the printout. Since this represents a potential patient safety 
issue, the custom tags will be ignored and <maintext> will be implied.
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Two example templates (Simple Reverse Template and the Complex Reverse 
Template) and their example results are shown on the next two pages, using the new 
merge fields to position the addendum text at the top of a printed report.

Simple Reverse Template Example and Result
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Complex Reverse Template Example
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Creating a Fax Template

To create a fax template: 

1. Create the fax template file in Microsoft Word or WordPad.

• Be sure to include at least the <maintext> merge field. To see a list of all available 
merge fields: 

 a. On the System or Sites tab in the Setup group, click Templates.

 b. Click the icon at the upper right portion of the Fax Template dialog box.

A window showing the list of merge fields opens. 

 c. To insert a merge field in the Word document, copy the field from the list. Be sure 
to copy the field exactly as it appears, including the brackets. 

2. Save the template as an .rtf file.

To add the fax template at the system, site, or site location level: 

1. To add the fax template at the system level: 

 a. On the System tab in the Setup group, click Templates.

 b. Select the Fax Template tab.
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To add the fax template at the site level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Click Templates…. 

 c. Select the Fax Template tab.

OR

To add the fax template at the site location level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location to which you want to add a fax template, click Edit… in the 
Templates column.

 c. Select the Fax Template tab.
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2. Click New.

3. Type a Name for the new fax template. 

4. Click Browse.

5. Navigate to and select the file you created in Word or Wordpad. Click Open.

6. Click Save. The template appears in the plain-text preview window.

To preview the template as it will appear with a report, click the link below the editing 
window. At the prompt, click Open. A sample report appears in a Word window. 
Close the window when you have finished.

7. Click Save and Close to save the fax template.
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Creating a Fax Cover Sheet

Creating a Fax Cover Sheet in Windows 7
In Windows 7 you can create a fax cover sheet using the Windows Fax and Scan program.

To create the fax cover sheet in Windows XP: 

1. Click the Start button , click All Programs, then click Windows Fax and Scan.

2. Make sure you’re in the Fax view by clicking Fax at the bottom of the left pane.

3. Click the Tools menu, click Cover Pages, and then click New. A blank window 
containing the available cover page tool opens.

4. To add commonly used label and text boxes to the cover page, click the Insert menu, 
and then do one or more of the following:
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• Click Recipient, and then click the type of recipient information that you want the 
cover page to display.

• Click Sender, and then click the type of sender information that you want the cover 
page to display.

• Click Message, and then click the type of message information that you want the 
cover page to display.

5. To add text, click the Text button on the toolbar, and then drag your pointer to 
draw a text box. Type the text that you want the cover page to display.

6. The following illustration shows an example fax cover sheet.

7. When finished, click File > Save and save the file to your preferred location. The 
cover sheet file is saved with a .cov file extension. 
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Creating a Fax Cover Sheet in Windows XP
Begin by creating a fax cover page in the Microsoft Fax Cover Page Editor utility. 

Note: To use this utility in Windows XP, you must first install the Fax service. Refer to your 
Windows documentation for information on installing this or other Windows components. 

To create the fax cover sheet in Windows XP: 

1. Select Start > All Programs > Accessories > Communications > Fax > Fax Cover 
Page Editor. The editing window opens.

2. Use the utility’s editing features to create the cover sheet. For more information, refer 
to the Fax Cover Page Editor’s online help. 
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Note: The utility allows you to insert merge fields by selecting Insert from the 
menu bar and then selecting fields from the Recipient, Sender, and Message 
submenus. The PowerScribe 360 Reporting application supports only the 
following fields: 

Recipient: Name, Fax Number

Sender: Name, Fax Number

Message: Note, Subject, Date Sent, Number of Pages

3. Click File > Save As….

4. Save the cover sheet to a folder on your computer. The cover sheet file has a .cov file 
extension. 

Adding a Fax Cover Sheet
Use the following steps to add the fax cover sheet you created (regardless of which 
version of Windows you used to create it).

To add the fax cover sheet:

1. To add the fax cover sheet at the system level: 

 a. On the System tab in the Setup group, click Templates.

 b. Select the Cover Sheet tab.
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To add the fax cover sheet at the site level: 

 a. On the Sites tab in the Setup group, click Templates…. 

 b. Select the Cover Sheet tab.

OR

To add the fax cover sheet at the site location level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location to which you want to add a fax template, click Edit… in the 
Templates column.

 c. Select the Cover Sheet tab.

2. Click New….

3. Enter a name for the cover sheet. 
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4. Navigate to and select the cover sheet file and click Open. Cover sheet files have a 
.cov extension.

5. Click Save. The template appears in the Select Template list.

6. Click Save and Close to save the template.

Modifying a Template

You can modify a print, fax, or cover sheet template for your system or site, and you can 
modify a template for a location within a site. 

Modifying Print and Fax Templates
To modify a print template: 

1. To modify a print template at the system level:

 a. In the Setup group, select the System tab. 

 b. Click Templates….

 c. Select the Print Template tab. 

OR

To modify a print template at the site level:

 a. In the Setup group, select the Sites tab. 

 b. Click Templates…. 

 c. Select the Print Template tab. 

OR

To modify a print template at the site location level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 
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 b. Next to the location to which you want to modify a print template, click Edit… in 
the Templates column.

 c. Select the Print Template tab.

2. Download the template file from the server, if the current version is not on your 
computer. Otherwise you can skip this step. To download the file:

 a. Select the template you want to modify from the list. The template appears in the 
plain-text preview window. 

 b. Click Download. 

 c. At the prompt, click Save. 

 d. Navigate to and select the folder in on your computer in which you want to store the 
template file.

3. In Word, open and edit the template file as desired. Save and close the file. 

4. Click Edit…. Navigate to and select the file you edited. The edited file appears in the 
plain-text preview window. To preview the template in Word, click the link at the 
bottom of the window; click Open to view a sample report. Then close the preview 
window. 

5. Click Save and Close to save your changes. 

To modify a fax template: 

1. To modify a fax template at the system level:

 a. In the Setup group, select the System tab. 

 b. Click Templates….

 c. Select the Fax Template tab. 

OR

To modify a fax template at the site level:

 a. In the Setup group, select the Sites tab. 

 b. Click Templates…. 

 c. Select the Fax Template tab.

OR

To modify a fax template at the site location level:
0 L-3906-006



Chapter 18: Order and Report Management

L-
 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location to which you want to modify a fax template, click Edit… in the 
Templates column.

 c. Select the Fax Template tab.

2. Download the template file from the server, if the current version is not on your 
computer. Otherwise you can skip this step. To download the file:

 a. Select the template you want to modify from the list. The template appears in the 
plain-text preview window. 

 b. Click Download. 

 c. At the prompt, click Save. 

 d. Navigate to and select the folder in on your computer in which you want to store the 
template file.

3. Open and edit the template file as desired. Save and close the file. 

4. Click Edit…. Navigate to and select the file you edited. The edited file appears in the 
plain-text preview window. To preview the template, click the link at the bottom of the 
window; click Open to view a sample report in an editing window. Then close the 
preview window. 

5. Click Save and Close to save your changes. 

Modifying Fax Cover Sheet Templates
To modify a fax cover sheet template: 

1. To modify a fax cover sheet template at the system level:

 a. In the Setup group, select the System tab. 

 b. Click Templates….

 c. Select the Cover Sheet tab. 

OR

To modify a fax cover sheet template at the site level:
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 a. In the Setup group, select the Sites tab. 

 b. Click Templates…. 

 c. Select the Cover Sheet tab.

OR

To modify a fax cover sheet template at the site location level:

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location for which you want to modify a fax cover sheet, click Edit… in 
the Templates column.

 c. Select the Cover Sheet tab.

2. Download the template file from the server, if the current version is not on your 
computer. Otherwise you can skip this step. To download the file:

 a. Select the template you want to modify from the list. 

 b. Click Download. 

 c. At the prompt, click Save. 

 d. Navigate to and select the folder in on your computer in which you want to store the 
template file.

3. In the Windows Fax Cover Page Editor utility, open and edit the template file as 
desired. Save and close the file. 

4. On the Cover Sheet tab in PowerScribe 360 Reporting, click Edit…. Navigate to and 
select the cover sheet you edited. 

Note: The preview feature is not available for fax cover sheets.

5. Click Save and Close to save your changes. 
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